
OrCAD 問題集錦 
ORCAD 如何吃 P-CAD2000 的檔案   

詳細說明 請問如果要從 P-CAD 轉到 ORCAD 的格式有辦法嗎   

 

在 OrCAD 的 Import 指令中有 PDIF 的規格 您可以由 P-CAD 轉出 PDIF 的格式 再由 OrCAD 讀入  

在 P-CAD 中有一些元件是 OrCAD 中無法支援 所以在 Import PDIF 檔案時可能會因為元件無法支 

援而 生錯誤 造成檔案無法讀入 所以在讀取 PDIF 檔案時必須注意元件問題 如 BUS Bus  

Entry 與一些 IC 元件...等等  

--------------------------------------------------------------------- 

如何在 layout plus 設定零件的高度,另外要如何才能在電路板挖一個 10mm x 5mm 的長方形的 

孔,煩請解答,謝謝 

 

1  您可以選擇 Tool 下之 Obstacle 的選項 執行後選擇 Place outline 的 Type 在其下方即 

一個 Height 的選擇項 在此輸入您所需要的高度再將之放置在電路圖中即可  

2 您可以在元件中擺置一個由 Via 構成之長方形的 Pad 再以此零件放置在電路圖中即可  

---------------------------------------------------------------------- 

layout 可否轉 3D 出圖  

詳細說明 我是個 orcad 新手,正在努力學中,因為公司的 品須要電路版的 3D 出圖所以有此疑問  

 

針對您的問題我已做了測試 在我們 Layout 中可以輸出 IDF 的格式 其內容可以由 Pro/E 讀取 

---------------------------------------------------------------------- 

Orcad 為何沒有支援 Pads PowerPCB 的 ASCII file format   

詳細說明 Pads PowerPCB 的 netlist file format 早期只要使用 pads2k 的 format 即可,但是後 

來其表頭更改為!PADS-POWERPCB-V3.0-MILS! DESIGN DATABASE ASCII FILE 2.0,變成我們每 

一次都必須用人工將*pads2000* 改為!PADS-POWERPCB-V3.0-MILS! DESIGN DATABASE ASCII  

FILE 2.0,造成我們 layout 人員很不方便,想與你們確認是否 Orcad 下次改版時,會加入 Pads Po 

werPCB 專用的 netlist format?  

 

對於您的問題,在原廠的下載區有符合 POWERPCB 的格式,其檔案為 Padpwr1.zip 的壓縮檔,其輸 

出的 Netlist 表頭為!PADS-POWERPCB-V2.0-MILS! DESIGN DATABASE ASCII FILE 1.0,您可以參 

考是否有誤 

---------------------------------------------------------------------- 

請問如何 import verilog file to orcad 

由於 OrCAD Capture 並沒有 Import Verilog 的格式,所以無法讀取 Verilog 的檔案,必須由 Veri 

log 輸出 OrCAD Capture 可以讀取的格式再由 OrCAD Capture 讀取檔案即可 

---------------------------------------------------------------------- 

標題 pspice9.0 如何更改元件參數  

詳細說明 pspice9.0 的元件從 library 叫出後.. 

選 edit properties 找不到參數的設定 

例如叫出某個型號的 FET 

想設定其 IS , Cd ,Cs 等等.. 

請問如何找到其參數與修改? 

若因為它是特定型號不能修改 

則可以叫出一個電晶體的 model 自設參數? 

  

在 Orcad 9.0 中,更改一個電晶體的元件參數的 Step 如下述: 

Step1: 在 Capture 裏,叫出其符號. 

Step2: 選欲更改的符號後, 選在 Orcad Capture Windows 裏的 

Edit/Pspice Model 選項. 



Step3: Orcad Model Editor Windows 出 後,您就可以更改元件參數. 

---------------------------------------------------------------------- 

請問 orcad 4.的線路圖如何給 orcad 7.讀 

 

Capture 如何開啟 DOS 版本的 SDT V3 / V4 及 SDT 386+ 之圖檔  

詳細說明 OrCAD Capture 如何開啟 DOS 版本的 SDT V3 / V4 及 SDT 386+ 之圖檔 

下列兩項條件必須具備   

你必須有 DOS 版的線路圖檔(*.SCH)以及該圖檔所有使用到的 

零件庫檔案(*.lib)   

最好零件庫檔是單一的專屬零件庫 

(這可以使用 DOS 所提供的 Libarch.exe 檔對該圖檔去製作出來)   

如果不是單一的零件庫檔案也是可以的 只是較為麻煩   

你最好在該部電腦安裝有 DOS 版的 OrCAD SDT  

之程式 如果沒有則您必須進行下列的 境設定  

境設定  

請在你的 Autoexec.bat 檔內加入一行設定 範例如下   

---------------------------------------------------------------------- 

@ECHO OFF  

PROMPT $P$G 

PATH C:\WINDOWS;C:\WINDOWS\COMMAND;C:\;C:\DOS;C:\ORCADWIN 

SET ORCADPROJ=C:\ORCAD 加入此行設定  

SET TEMP=C:\TEMP 

LH MOUSE 

LH DOSKEY 

***************************************************************** 

請從原來裝有 OrCAD SDT 程式的電腦尋找一個 SDT.CFG 檔 

(該檔案一般是放在\ORCAD\TEMPLATES\ 目錄下   

如果您找不到此檔案 亦可從 OrCAD 的網站(www.orcad.com)上去取得 

該檔案   

然後使用文書編輯軟體去開啟該檔案 並將此檔案修改如下   

{OrCAD/SDT IV Configuration File } 

PDRV = C:\ORCAD\  

PSCH =   

PLIB = C:\ORCAD\*.LIB   將 LIB 的路徑設為 ORCAD 之目錄   

DD = VGA640.DRV  

PRD =    

PLD =    

LIB = 'MYPROJ.LIB  輸入您的零件庫檔名 有幾個就加入幾行  

LIB = DEVICE.LIB  

   

   

DMF =   

DIM =   

LMF =    

假設你的圖檔與零件庫檔名分別為 MYPROJ.SCH 與 MYPROJ.LIB  

則請在 C 磁碟建立一個 ORCAD 目錄 並且把圖檔 MYPROJ.SCH 與零件庫檔  

MYPROJ.LIB 複製到此目錄下 然後也將上述已修改好的 SDT.CFG 檔複 

到此目錄下  將 \ORCADWIN\CAPTURE\ 路徑下的 Capture.ini  

檔內容修改如下範例  

 



************************************************************  

Part Selector Configured Libraries]   

Number of Configured Libraries=2   

Library0=C:\ORCADWIN\CAPTURE\LIBRARY\ANALOG.OLB 

Library1=C:\ORCADWIN\CAPTURE\LIBRARY\DEVICE.OLB  

  

************************************************************  

************************************************************  

[Part Selector Configured Libraries]  

Number of Configured Libraries=0   

開啟進行檔案轉換  

避免程式在轉換時先去抓取原來 Capture 所加入選用之零件庫  

 

************************************************************  

進入 OrCAD Capture 程式內 然後在功能表選擇 Open - Design   

在 Open Design 的對話框內切換檔案類型為 SDT Schematic  

(*.sch) 然後進入 OrCAD 目錄去開啟 MYPROJ.SCH 圖檔 並將它轉存為 

DSN 檔(OrCAD Capture 檔案格式)即可 

---------------------------------------------------------------------- 

標題 請問如何設計和建立自己的焊 &  

詳細說明 在 PCB 零件中的焊 如何設計並建立自己的焊 庫.  

 

在 PCB 中的焊 (Pad)是一?物件 所以不管是單?的 Pad 與元件的 Pad 皆為同一設定  

您在 library 中選擇您要??之 Pad 再按下 Shift 與 T 鍵即會切換至 Pad 的設定?窗下 您再依據 

您所需要的設?來作?更即可(元件也是相同做法)  

---------------------------------------------------------------------- 

標題 請問 PSpicead 的問題?  

詳細說明 我的問題為 我每次模擬時,PSpicead 中的 Display 都為"Fast", 

是否可以設定那裡?可以每次模擬,PSpicead 中 Display 為"immediate",這樣模擬比較快..... 

 

在 PSpiceAD window 中的 Display item 裏,我們利用 Immediate,fast,slow 選項 

來決定更新 PSpiceAD window 資料的速度(Immediate 最快,fast 居中) 

然而就模擬而言,顯示資料更新的頻繁,佔據程式更多的時間,而使模擬速度變 

慢.因此,單就模擬時間而言,我們建議您使用 slow 選項若有更進一步之問題 歡迎指教 

---------------------------------------------------------------------- 

標題 OrCAD Capture 9.2 有關 Capture Netlist 問題  

詳細說明 問題 1 Capture 新版的 Netlist to Allegro 功能 

有無更詳細的說明 User Guide 寫的相 簡陋 

問題 2 某一零件的所有 Pin 都接電源 就出 Error  

這並不合理 因為如 CPU 一般都會分成 ABCD 等部份 

而某部份是所有 PIN 都是接 POWER 和 GND  

這種 Message 就不合理 

問題 3 由 Capture 生 Netlist 且 選開啟進入 Allegro 

這之間處理所花的時間 遠比之前用 Third Party 方式 

超過太多(太慢) 而新版 Capture 又無提供舊方式的  

生方式 害我只能將舊版的 Allegro.dll Copy 到 

Capture\netsform 下 才能用舊的方式 生 NetList 

為什 新版的問題那 多 而且又不 Friendly... Why?  

---------------------------------------------------------------------- 

A1:請參考 help 之 netlist to allegro 其中如 assign properties in Capture for use in  

Administrator
高亮



Allegro 即會說明例如何將 VDD,VPP,VSS 綁成 VCC 訊號之 PROPERTIES => POWER_GROUP = VDD=V 

CC;VPP=VCC;VSS=VCC 

A2:請務必用 orcad 9.2.3(allegro 14.2).即可不須同一零件中 in name 須不同 orcad 9. 

2.2 有此限制 

A3:新轉法的特性是除了傳遞 NETlist 之連線關係外更能傳遞對零件或訊號所定之 PROPERTIES 

如 FIXED,min_line width 等宣告.會轉出三個 .dat 

如果只要 NETlist 作 LAYOUT.如您所做將舊版的 Allegro.dll 覆製到 Capture\netsform 下用 cr 

eate NETLIST/OTHER/Allegro 轉出單一 netlist. Allegro 

---------------------------------------------------------------------- 

OrCAD Capture 9 23 Netlist to Allegro  

詳細說明 關於之前提過的問題 同一 Part 有相同 PinName 會 生 Error 

如下所示 (只是截取部份的錯誤訊息 有近 2 萬的 Errors) 

#7874 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7875 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7876 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7877 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7878 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7879 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7880 Error [ALG0050] Duplicate Pin Name "GND" found on Package VT8235A , U37A:  

main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7881 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7882 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7883 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7884 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7885 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7886 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7887 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7888 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7889 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7890 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

#7891 Error [ALG0050] Duplicate Pin Name "VCC33" found on Package VT8235A , U37A 

: main, 16 SOUTH BRIDGE 1 (2.40, 1.60). Please renumber one of these. 

 

這是用 Cadence 14.2 內的 Capture 轉出的  



請問如何更正這些錯誤..... 太多了 

而且這種錯誤訊息應該是可以改成 Warnning 而不應該是用 Error 

進而造成 Create Netlist 的中斷 不是很合理 

PS: 本人對於這種 Create Netlist 的方式覺得很不錯 只是過程中仍有一些無法理解的問題 

....  

  

答  

有 Duplicate Pin Name 表示您所建的 Orcad Library Part 的 Pin Name 一樣 

可能要改成不同 Pin Name 才可以如加上 0,1,2,3...的編號 一般來說 Pin name 若不同的話 

在建 Part 時就有 Warning Message 但是有些使用者就忽略這些 Message, 在舊版的 Capture 因 

為是用 Third Party 方式轉成 Allegro Netlist 然是沒有問題 但在新版的 Netlist to Al 

legto 就會出 Pin Name 重覆的問題...... 

---------------------------------------------------------------------- 

OrCAD Capture 9 1 

標題 .DSN 的版本  

詳細說明 為何無法將 9.1 的 DSN 存為 7.2 的 DSN.之前都可以(用的是 OrCAD Capture CLS9.1)  

RE  

在使用 Capture9.1 的程式 再開啟電路圖 再執行"Save as"功能後 在存檔類型中即有 7.2 

格式的選項 您可以選擇 7.2 的格式存檔即可  

感謝您的指教  

 

---------------------------------------------------------------------- 

OrCAD Capture 9 02 

標題 有問題~~  

詳細說明 layer name 中文說明 副檔名 

Silkscreen Top 頂層文字絹印層 .SST 

Silkscreen Bottom 底層文字絹印層 .SSB 

Top Layer 頂層零件面走線層 .TOP 

Bottom Layer 底層銲錫面走線層 .BOT 

Inner Layer 1,etc. 中間銅箔走線層第一層 第二層 等  .IN1,IN2  

Power Layer. 內層電源層 .PWR 

Ground Layer. 內層接地層 .GND 

Soldermask Top 頂層防銲層 .SMT 

Soldermask Bottom 底層防銲層 .SMB 

Solder Paste Top 頂層錫膏印刷鋼板層 .SPT 

Solder Paste Bottom 底層錫膏印刷鋼板層 .SPB 

Drill Drawing 鑽孔尺寸標記層 .DRD 

Assembly Top 頂層資料圖 .AST 

Assembly Bottom 底層資料圖 .ASB 

Global Layer 禁入(置)層 

 

請問上述的那些檔案用.max 檔轉換的步驟為何?? 

在 ORCAD Layout 中,是否有副檔名為 .drd 的檔案 

如果有,該如何叫出來?? 

謝謝!!  

 

RE  

轉出 GerberFile 步驟如下 

1.執行 Options 下 Post Process Settings 功能 

2.再按滑鼠右鍵 選擇 Run Batch 選項即可 



3.與"*.max"同一個檔案夾中即會出 所有的 Gerber 檔案 

 

有副檔名為 DRD Drill Drawing 鑽孔尺寸標記層 .DRD 您轉出 GerberFiles 即會有  

謝謝您的指教 

------------------------------------------------------------------------------- 

OrCAD Pspice 9.02 

標題 請問一下 layout 輸出副檔名  

詳細說明 請問一下... 

零件面,銲錫面,鑽孔檔,成型檔 

layout 輸出的副檔名各是什 ??  

 

RE: 

您好: 

您所需要的資料如下: 

layer name 中文說明 副檔名 

Silkscreen Top 頂層文字絹印層 .SST 

Silkscreen Bottom 底層文字絹印層 .SSB 

Top Layer 頂層零件面走線層 .TOP 

Bottom Layer 底層銲錫面走線層 .BOT 

Inner Layer 1,etc. 中間銅箔走線層第一層 第二層 等  .IN1,IN2  

Power Layer. 內層電源層 .PWR 

Ground Layer. 內層接地層 .GND 

Soldermask Top 頂層防銲層 .SMT 

Soldermask Bottom 底層防銲層 .SMB 

Solder Paste Top 頂層錫膏印刷鋼板層 .SPT 

Solder Paste Bottom 底層錫膏印刷鋼板層 .SPB 

Drill Drawing 鑽孔尺寸標記層 .DRD 

Assembly Top 頂層資料圖 .AST 

Assembly Bottom 底層資料圖 .ASB 

Global Layer 禁入(置)層 

------------------------------------------------------------------------------- 

OrCAD Capture CIS 9.0 

標題 為什 V:9.0 和 V9.1 的 Logic IC 操作方式不同  

詳細說明 V9.0 的 Logic IC 使用複合包裝零件(U?A,U?B..)在置放於電路圖時會自動增加 Part 

 numbering(ex:U1A 在置放後,置放下一個則編號增為 U1B),但 V9.1 確增加零件編號(ex:U1A 置放 

後,下一個編號增為 U2A),請問是設定問題還是版本問題.如果要 V9.1 使用 V9.0 的方式可以嗎?? 

 

RE: 

關於您的問題,在這兩個版本並無不同 

在複合式的零件裡,做重覆放置的動作, 

其 Part Numbering 都會自動遞增 

(EX:U1A U2A......) 

因此您所發 的問題,應該是不會發生才是. 

 

如有進一步的問題,歡迎指教...... 

------------------------------------------------------------------------------- 

DSN 的版本  

詳細說明 請問如何看的出來 DSN 的版本?!  

RE: 

您好: 



您可以 UltraEdit 或一些可能看 

檔案 ASCII 的文書編輯軟體, 

從 ASCII 裡就會有敘述那個 DSN 

是那個版本所建立. 

 

如有進一步的問題,歡迎指教...... 

hofc@ms68.hinet.net <hofc@ms68.hinet.net> 

------------------------------------------------------------------------------- 

OrCAD Capture 9.0 

請問電路圖是否可以轉換成 PowerPCB 的檔案(.pcb 檔)  

詳細說明 OrCAD Capture CIS 中的電路圖是否可以轉換成 

PowerPCB 的檔案(.pcb 檔)  

 

RE: 

如果您要由 OrCAD Capture 的電路轉 Netlist file 到 Power PCB 請再執行 Create Netlist 功 

能後 選擇 Other 選項的 Pads2k.dll 再將*.NET 更改為*.ASC 即可由 Power PCB 中載入 Netlist 

 

至於載入方式請詢問 Power PCB 的代理廠商 如此才會得到最正確的做法  

------------------------------------------------------------------------------- 

OrCAD Capture 9.0 

標題 繪圖檔可否轉為 pdf 檔  

詳細說明 繪圖檔可否轉為 pdf 檔,how to do  

 

RE: 

您好: 

關於您所提出的問題,這是 Acrobat Write 才有的功能, 

而此功能是要付費的.您可以到下面所列的網頁上,穫得到更詳細的說明: 

http://www.adobe.com/products/acrobat/readstep.html 

------------------------------------------------------------------------------- 

OrCAD Capture CIS 9.0 

自建零件修改後如何同步使用於電路圖  

詳細說明 建完零件後,用於電路圖上,但如果要修改自建零件,修正完後,電路圖上卻無法自動 

更新成零件庫所修正的零件,請問要如何設定才能同步更新呢????或有其他的方式. 

Thanks.  

 

RE: 

您好: 

關於您的問題,您可以用 Update Cache 的動作 

將電路圖上的零件 Update 成跟 Library 一樣. 

其做法如下: 

1.到 Project Manager 視窗,並將 Design Cache 展開 

2. 選該元件(會 Highlight 起來) 

3.將滑鼠移到上 Mean Bar 找 Design ->Update Cache 即可. 

------------------------------------------------------------------------------- 

OrCAD Layout 9.0 

標題 Gerber file merge  

詳細說明 Sir, 

 

我想將不同的 max file 放在同一個 gerber file 上 (2 種不同的 pcb 放在同一個 panel, 我 

試過用 merge 這個命令, 但出來的結果是令一塊板所有的 pad size 同 drill size 都變了, 



我是否做錯了?? 

Thanks !!! 

 

Ming  

 

RE: 

一般併版的用途是用在於將相同的 PCB 檔案作複製 使用在 PCB 已製作完成要輸出 Gerber fil 

e 前 所以您的做法用在這裡不太恰  

在我們的操作中 Pad 的資料並沒有不同 所以不知您出 的錯誤為何  

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Layout  

標題 How to convert format from *.max to *.pcb   

詳細說明 Sir, 

 

有沒有方法可由 *.max file (orcad layout) 轉到 pcb file (powerPCB) ? 

我試過由 max 轉 gerber, 再由 gerber 轉 pcb, 但是 pcb file 就不可再做更改,這只是表面. 

.. 

謝謝!!! 

 

ming 

  

RE: 

您可以在進入 Layout 後直接使用 File 下的 Export 指令 在此指令中選擇您所要的格式  

您可以選擇 power PCB 的前一個版本 PADs 的格式 再由 power PCB 中匯入即可  

由於 power PCB 不屬於 Cadence 的軟體 在此無法為您解答 所以在 power PCB 中如何匯入與修 

改請詢問 power PCB 的廠商  

感謝您的詢問  

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Layout  

標題 請教各位前輩,如何設定盲孔和埋孔?  

詳細說明 請教各位前輩: 

盲孔和埋孔要在那個功能中設定?請指 .. 

感激不盡.  

  

RE: 

您可以進入 padstacks 中將不需要的層別關閉(Pad Width 與 Pad Height 修改為 0)即可  

例如:六層版中的埋孔設定 您可以進入 Padstacks 中 針對所需修改的 Pad 關閉不使用的層 

別(如 Top,Inner1,Inner4,Bottom)四層資料 如此即成為只有 Inner2 與 Inner3 的埋孔了  

同理可以設定 Inner2,Inner3,Inner4,Bottom 關閉 如此即設定為半埋孔了  

感謝您的指教  

------------------------------------------------------------------------------- 

版本 13.6  

問題類別 Cadence Allegro Studio  

標題 為何無法將 NET 檔載入  

詳細說明 請問: 

我在 allegro 中的 File->Import->Logic 輸入 NET 檔卻無法載入 

我該使用何種方法載入 ORCAD 的檔案做 Layout  

 



RE: 

請確認在 Orcad 中是用 Create Netlist/others/Allegro 來 生 Netlist File 

在 Allegro 中是用 File/import/logic/Third Party 模式來載入 

否則 Netlist 只是交待零件外型及連線關係至 Layout tool 中,格式對了只差兩邊是否對應的 

問題 

 

請依其錯誤訊息與您的支援廠商查核 

------------------------------------------------------------------------------- 

版本 9.1  

問題類別 OrCAD Capture  

標題 請教我如何在 pspice9.1 下設 kp 值??  

詳細說明 上次我寫的不夠清楚~ 

這次我說清楚一 我不會 irf150 的 kp 值~ 

題目要我用參數掃描的方式來分析 nmosIRF150 的模型參數 kp 值分別為 20u 40u 60u 時的 

輸入輸出轉換電壓圖 

可是我在 capture 中找不到可以設 kp 值的地方~ 

請教教我~ 謝謝~  

 

RE: 

 

此 Kp 值是在 model 裡,所以在 Capture 中您看不到 

如果您想知道 kp 在那裡,你可以跟著下面的步驟做: 

 

Step 1:在 Capture 選該元件(會有粉紅色的 highlight) 

Step 2:在令命令列找 Edit->PSpice model 就可以看到此個元件的 model. 

裡頭就有 KP 的值(此為原來的設定) 

 

至於您要如何做 kp 值的設定及模擬,你可以跟著下面的步驟做: 

Step 1:在模擬設定裡選擇 DC Sweep 並做好設定. 

Step 2:在同一視窗的左下有 Option,請勾選 Secondary Sweep, 

會出 跟 DC Sweep 一像的設定 面 

Step 3:在 Sweep Variable->Model parameter 

Model type ->選擇該零件的格式(Ex:NPN ..etc) 

Model name ->電路圖上該零件的編號(Ex:Q1 ..etc) 

Parameter name->設定該零件的參數名稱(Ex:Kp ..etc) 

Step 4:在 Sweep Type ->Value list 設定成 20u 40u 60u 即可. 

Step 5:做完模擬後, 選您想看的節 ,就可看到您要的結果. 

 

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Pspice  

標題 請問若 VPWL 超過八組參數,該怎 設定  

詳細說明 請問我如果需要輸入一個驅動 IC 波形,則需要超過十二個以上的(T,V)設定,可是 PS 

PICE 的 VPWL 只提供八組,請問該如何使用呢?謝謝  

 

RE: 

您好: 

您可以使用 VPWL_ENH 這個零件代替 

在 "FIRSTS_NPAIR" 做(T,V)的設定即可  

Ex:(1m,1v)(2m,3v)....(T,V) 



如果您想要所設的波形有週期性,請在 

"Repart_value" 設定成-1 即可. 

------------------------------------------------------------------------------- 

版本 14.1  

問題類別 Cadence Allegro Studio  

標題 power plane 走線, gerber 如何出負片  

詳細說明 PSD14.1 是否允許在定義為負片層走線? 如何出 gerber?  

 

RE: 

power plane 走線只要將其層面設為 conduct 成一加般走線層面 先走線再鋪銅  

鋪上去的銅會依設定自動避開先前所走的線 到時出一張正片即可  

 

若是負片層要走線則要開一層只走內層線 並將加粗後之效果製作在負片層上 最後出底片 

時要出內層負片(plane)及正片(走線)兩個 erber 再 合  

要是負片層走線不多則利用切割作出其效果 不用出兩張底片再 合  

------------------------------------------------------------------------------- 

版本 none  

問題類別 OrCAD Layout  

標題 Layout 上的問題  

詳細說明 在單面板上如何做出水滴狀的佈線(使用 Dip 零件 )  

 

RE: 

在 Layout 中並無直接做出淚滴的功能 您可以利用 free track 在 pad 左右各補一條走線,使 

之達到淚滴的功能  

------------------------------------------------------------------------------- 

版本 9.2  

問題類別 OrCAD Capture  

標題 如何找到元件庫中沒有的 SPICE MODEL  

詳細說明 想要找到 MMBV609LT1 這個元件的 SPICE MODEL 請問要到哪裡找 

  

RE: 

關於您的問題,您可透過下列幾種方式去找尋元件的 model. 

可從網上去做搜尋(例如 WWW.PSpice.Com)或從零件供應商取得 

如果都沒有的話,最後您也可以用等效電路的方式來做模擬 

------------------------------------------------------------------------------- 

版本 orcad releace9  

問題類別 OrCAD Capture  

標題 無法進入 orcad,救救我吧!  

詳細說明 為什 我安裝了 orcad 9 之後,我進入 orcad 的任何一個程式都顯示 

[2001]Unable to find a license file . 

correct the error and chick "Retry",or  

chick"cancel"to about the program. 

我隨便按了個鍵就跳開了,我有下載單機版的安裝步驟但都是亂碼 

,所以請指導一下,感激不盡!  

 

RE: 

軟體沒解密 找一個解密程式將其解掉即可  

-------------------------------------------------------------------------------= 

版本 9.2  

問題類別 OrCAD Capture  



標題 馬上知道某個零件 在 layout 上外型  

詳細說明 在 Capture 的 Schematic 圖中 如果要知道某個零件 在 layout 上 

外型(pack) 我該如何作  

 

RE  

在 Capture 中並無觀看 Layout footprint 的功能 如您要觀看 Layout 的外觀只有 Capture CIS 

的程式才有此功能 而其外觀只有 OrCAD Laout & Cadence Allegro 兩種 Layout 軟體才可觀看 

其 Layout 外觀圖  

------------------------------------------------------------------------------- 

版本 micro sim 8.0  

問題類別 OrCAD Pspice  

標題 有個相依電源的問題想請教  

詳細說明 1.如果有一行 pspice 的語法 

EF1 SF1 MF1 POLY(2) TF1 0 TF2 0 0.0 -1.707 0.707 

( EF1=-1.707VTF1+0.707VTF2) 

這是一個電壓控制電壓源的元件 他有四個端  

我這四個端 要如何去設定,要如何把他連接起來 

2.如果我想找有關多條傳輸線耦合,去耦合變成單跟理想傳輸線 

的問題要找哪些書?? 

3.如果我有關這方面的問題,在網上留言不清楚可以到貴公司去請 

教你們的工程師嗎 

 

謝謝  

 

RE  

1.Pspice 裡面的 E_poly 元件,僅有一個變數來做電壓控制,無法直接轉 

成您所描述的格式(兩個變數來做電壓控制),因此若要達到您的需求, 

則需要請 您參考相關的書籍並建立兩個變數控制的 E_poly 元件. 

(您可以到 http://www.orcad.com/technical/library/analog/analog.asp 的網站,下載相關

Pspice 的說明電子檔) 

 

2.關於您說的"多條傳輸線耦合,去耦合變成單跟理想傳輸線"的問題,看不出是屬於那方面的 

問題.因此如果可以的話,煩請說明一下 您設計 

電路的方式.至於書籍方面,很遺憾沒有很的資訊可提供給您. 

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Capture  

標題 如何在 G 元件中輸入變數   

詳細說明 一般在使用 G 元件(電壓控制電流源)時 GAIN 參數只能輸入常數 但是我 在需要 

讓 G 元件的輸出電流為輸入電壓的倒數 也就是 GAIN 參數需輸入 1/Vin 請問 Capture 是否有提 

供此功能 謝謝   

 

RE  

您可以使用"GVALUE"這個元件,在 EXPR 這個參數只要設定成 

"1/(%IN+,%IN-)",就可以達成您的要求. 

------------------------------------------------------------------------------- 

版本 9.1  

問題類別 OrCAD Layout  

標題 如何將 Capture 的檔案轉入 Layout 的 MAX 檔案  

詳細說明 如何將 Capture 的檔案轉入 Layout 的 MAX 檔案  



例如在 Capture 的電路圖做好後 要用 Layout 來佈線   

 

RE  

您好: 

您必須先在 Capture 中設定 Layout 所需的 Footprint 您 Footprint 輸入完成後即可輸出 Net 

list File  

再直接進入 Layout 程式中 選取 File 中的 NEW 指令﹔使用 DEFAULT.TCH 技術檔 再指定您所輸 

出的 Netlist file 即可  

------------------------------------------------------------------------------- 

版本 9.00b  

問題類別 OrCAD Layout  

標題 單層板佈線  

詳細說明 * 使用 layout plus 作單層 BOTTOM 佈線,TOP 層設為 Jumper Layer 

Jumper Attributes 內 Jumper 1 length=100, Jumper 2 length=200,Jumper 3 length =30 

0 後. 用 Smartrute autoroute board 自動佈線完成後發 仍有幾條鼠線 未完成佈置.為什  

沒自動放置 Jumper1 or 2.....?? 

單層板佈線應如何設 Jumper?? 謝謝回答!! 

  

RE  

您所敘述的 Jumper 是 Layout 的功能而非 Smartroute 的功能 所以在 Smartroute 中是無法達到 

您所設定的功能  

您可以在 Layout 中執行 Autoroute 則可以出 jumper  

------------------------------------------------------------------------------- 

版本 9.00b  

問題類別 OrCAD Layout  

標題 接地/layer  

詳細說明 你好: 

 

* 設計腳針式雙面板,壹鋪銅區欲接地 obstacle type-copper area, Net attachment-GND P 

OWER, component reference designator-U1(ex.8051), pin name-20.發 U1 與鋪銅區成一體 

. 

但 autoroute board 完成後卻無連結???? 

* 借 library manager 之零件皆有 POWER/GND 層(灰色).設計腳針式雙面板設 TOP/BOT 設 routin 

g 餘設為 unused 

但在 post process 中仍有*.PWR/*.GND 層,是否正確?? 

* 由*.mnl 轉來圖可否先手工怖線重要線路,其餘由 smrtroute 

autoroute board 來完成?試好幾次皆無效! 

  

RE  

您可以先執行 Auto 中 Refresh All 的指令 此指令可以將所有物件重新整理 如此即可將銅鉑 

重新整理  

輸出的板層取決於 Post process 中是否有此資料 如您不想輸出*.GND 與*.POWER 兩層 請您 

將 Post process 的*.POWER 與*.GND 刪除 則輸出的 Gerber 中即不會輸出此資料 如您刪除後想 

再加入*.POWER 或*.GND 則在 Post process 新增回來即可  

可以先在 Layout 中繪製重要線路 再於 smartrote 中選擇 options 下之 Net properties 將您佈 

好的走線使用 unrote 則在 Auto route 後此線段即可保留  

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Layout  

標題 如何將 lay 好的線路做成連板  



詳細說明 如何將 lay 好的線路做成連板  

 

RE  

一般製作連板大多是在 CAM 的軟體中處理的 如您在 Layout9.0 中可能無法達成連板的動作  

------------------------------------------------------------------------------- 

版本 9.00b  

問題類別 OrCAD Layout  

標題 pad & via  

詳細說明 你好: 

* 如何設 pad 直徑和 solder mask expansion 的直徑,就是 pad 和防銲漆之間的空隙,要使零件針 

腳吃銲錫的地方.在 library manager 中找好久指令皆無法完成!(vias 同樣問題!) 

* pbc 板的螺絲固定孔如何設定?如 4.5mm 直徑圓周要吃銲錫空隙! 

試了很多指令皆不得其門而入,幫幫忙! 

* 在 top layer 設一四方形鋪銅區,如何設為不噴防銲區.亦是要接地和可銲區? 

* 板層設雙面板,top/bottom 層為 routing 其餘皆設為 unused. 

用 run post processor 轉 gerber 檔後,為何出 *.GND/*.PWR layer? 這是否正常? 

 

以上問題是否幫幫忙! Mnay Thanks!  

  

RE  

您好: 

針對您的問題我一項一項回您  

1.您選擇 View 下 Database spreadsheets 中的 Padstacks 功能 執行後找到相對應的 Pad 資料  

在其中更改各層別中的 Width 與 Height 即可改變其直徑  

2.您可以製作一個螺絲固定孔的 Pad 資料 將各 Route layer 的 Width 與 Height 資料設定比 Drl 

dwg 與 Drill 層別小即可  

3.您在放置銅箔後再複製一筆資料 將其層別設定為 SMT(頂層防焊層)SMB(底層防焊層)即可 

將此銅箔區域上綠漆(不可鍍錫) 反之如無相同資料在 SMT 與 SMB 如此這個銅箔區域即可上錫  

4.*.GND 與*.POWER 為層別中之內層電源層如您無此需求則將 GND 與 POWER 層別設定為 Unused R 

outing 即可將 GND 與 POWER 關閉 如您的設計有內層電源層則必須開啟  

------------------------------------------------------------------------------- 

版本 9.1  

問題類別 OrCAD Capture  

標題 IGBT model 如何 Include 至零件中  

詳細說明 您好: 

使用 pspice 來模擬電路,元件中有 IGBT 但是沒有 Model,我至元件供應商下載 pspice 的 model,但 

是我應如何加至 library. 

另外有些元件無法加入 pspice 的 model,出 undefine 的 Error,在 simulation 的時後,請問該如 

何解決. 

  

RE  

1.下載的這個 model,若要加到 Pspice 去做模擬,有三個步驟: . 

(1).建立一個新的元件(For Pspice).  

(2).並在 Symbol 的屬性裡,加上 PSpiceTemplate 的描述格式(For Pspice netlist).  

(3).將下載的 model 加入到模擬的設定(For Pspice's model link).  

 

2.這個訊息表示,您 叫取的元件並不是 For Pspice (因為沒有 model),純粹只是 Symbol 而已 

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Capture  



標題 有個關於傳輸線問題想問大家  

詳細說明 我想用元件 T2couple 來模擬兩根輸線,請問 T2 couple 跟 T2couple X 有什 不同, 

 為什 我用 T2 couple 來模擬兩根傳輸線耦合的波型模擬出來的都是錯的,我的 L11=L22=341n 

H L21=L12=58nH,C11=C22=76.6pF,c21=C12=-14.6pF 電壓是 VPWL 

傳輸線長度 123m 

 

那參數設定值是不是 L=341nH Lm=58nH C=76.6pF Cm=-14.6pF LEN=123m 

如果我設的不錯 那請問我還有哪些地方有可能錯ㄋ??? 

我的 VpwL 在 spice 語法是 VPWL(0 0 0.5us 0 0.75us 2.4 4us 2.4 4.25us 0) 

我在 orcad 裏設定的是 t1=0 v1=0 t2=0.5u v2=0 t3=0.75u v3=2.4 t4=4u v4=2.4 t5=4.25u  

v5=0) 

請問我有哪些地方設錯嗎  

 

RE  

關於您的問題,分兩部份來說明: 

1.編輯新的 TitleBlock -> 開啟 Capsym.olb 並開啟 TitleBlock 的 library,即可 

編輯裡頭的 TitleBlock(PS:請另存新的檔名). 

 

2.開啟一張電路圖,在 Menu Bar 的 Option ->Design Template ->TitleBlock 

可做 Orgnization Name,Document Number,Revision 等的設定. 

(ps:裡頭的 Symbol --> 

Library Name:若存在 Capsym.olb,此路徑不用給;若存 

在不同的路徑,請給完整的路徑(Ex: "c:\lirary.olb") 

Title Block Name:打上要叫取 TitleBlock 的名稱. 

 

3.加入 TitleBlocek 到圖檔裡,有兩個方式: 

(1).在電路圖裡在 Manu Bar 的找 Place -->找 TitleBlock 加入即可. 

(2).或是在步驟 2 設定好 TitleBlock 的路徑和名稱,在新增一個新圖時, 

即可直接套用. 

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Layout  

標題 救救我  

詳細說明 如何在 LAYOUT 中改銲 的大小~~`不是孔徑的大小~~~ 

謝謝~~~可以快一 回我嗎~~~ 

我很需要~~~~  

 

RE  

 

您好: 

請您在 Database Spreadsheets 選項中執行 Padstack 指令 在其表單中選擇所需更改的 Pad 資 

料更改成你所需的大小即可  

------------------------------------------------------------------------------- 

版本 8.0  

問題類別 OrCAD Pspice  

標題 請問如何把 pspice 的電路圖貼在 word  

詳細說明 如標題請問要如何把 pspice 的電路圖貼在 word  

 

RE  

關於您的問題 可直接在 PSpice 的電路圖上圈選(用滑鼠按住左鍵 並拖拉您的滑鼠)您想要 



的部分 並使用 PSpice 的 Copy 命令 再將 Word 打開 直接使用 Word 的 Paste 的指令 即可達到 

您要的功能  

------------------------------------------------------------------------------- 

版本 9.0  

問題類別 OrCAD Capture CIS  

標題 請問如何編製專屬電路的零件庫?  

詳細說明 您好: 

因每個零件都有其專屬的零件庫檔案,以至於佔用不少容量,但是如 orcad4.0 有編制其專屬零 

件庫的功能(即是把各個零件庫中有用到的零件另外存成一個零件庫) 

不知 orcad9.0 是否有? 

非常感謝您的協助 

  

RE  

在 Orcad Capture(包含 Capture CIS)裏 都可以做到 您想要的功能 在 

Windows 版本裏的 Project manager 視窗(類似像檔案總管的架構去裏)裏  

有 Design Cache 這個資料夾(此資料夾即是在存放有"叫取過的零件" 會在 

此做個列表)   

 

 您可以打開這個電路圖在 Menu bar 裏的 File-->New--> Library ( 此時會在 Project 

manager 的 Library 資料夾出 一個新增的 Library ) 此時再將 Design Cache 下所列的零件選 

取 ( 可按鍵盤上的 Shift 及滑鼠 選頭及尾 即可全選 ) 並按下 Copy 的小圖示 ( 在工具列 

的下方可找到 ) 再將滑鼠 到到剛剛新增的 Library 上 ( 會出 藍底白字 表已選取 )  

最後再按下 Paste 的小圖示 即可存成另一個零件庫 若要改名 則可 此 Library 並按右鍵 

會彈出一個小視窗 選擇 Save as 即可  

------------------------------------------------------------------------------- 

版本 9.1  

問題類別 OrCAD Layout  

標題 drill 的格式設定問題  

詳細說明 你好,我將.mnl 的檔案轉換成 layout 之後為什 drill chat 的鑽孔 

size 為何都變成全都只剩一格一樣的大小,Footprint 是自己做的有問題 ,可是明明 Drill 有 

大有小的啊,似乎都無法從 Drill chat 中修改導孔尺寸的大小,而且導孔的尺寸太大了要從哪裡 

修改呢? 

麻煩告知 謝謝  

 

RE  

如果您需要更改 Via 的孔徑大小則須將 Padstacks 的功能開啟 再增加一個 Via 的資料 然後再 

執行 tools 下的 Via 指令 選擇您所需要更改的 Via 再按滑鼠右鍵選擇 properties 在資料中 

即有 Padstack name 可切換 Via 孔徑大小  

------------------------------------------------------------------------------- 

版本 7.2  

問題類別 OrCAD Capture  

標題 DSN 轉成 OLB  

詳細說明 請問可否將線路圖使用到的零件 

轉成..OLB 的檔案格式 

 

RE  

 

要將電路圖上(DSN)所使用到的零件轉成(.OLB)的檔格式,其步驟如下: 

 

Step 1:先到 Project Manager 視窗下,在最上面的 Menu bar 找尋 file 



會有一個下拉式的選單--> new--> Library.此時在 Project Manager 的 

Library 會新增一個 Library1. 

 

Step 2:在將 Project Manager 視窗下的 Design cache 的所有零件(左手按住鍵 

盤上的 "shift" 鍵+右手則用滑鼠 選第一個零件及最後一個),並在上  

面的快捷鍵,選擇 Copy 小圖示, Copy 下來. 

 

Step 3:此時用滑鼠 到剛剛新增的 Library1,再執行 Paste 的指令(一樣的快捷 

小圖示可找到)即可. 

 

Step 4:最後一步"存檔"(別忘了) 

一樣選擇 Library1,並按滑鼠右鍵--> Save 或 Save as 的指令. 

------------------------------------------------------------------------------- 

版本 9.1  

問題類別 OrCAD Capture CIS  

標題 ODBC 的問題  

詳細說明 我想要使用 odbc 的設定與我的資料庫作連結 

請問 

在 orcad 中如何設定 odbc 及其運作方式  

 

RE  

您可以在 ODBC 的"系統資料來源名稱"中新增一筆您的資料庫檔案 再至 CIS 系統下的"Option 

s"下"CIS configuration"功能中連結 ODBC 即可 謝謝您的指教  

------------------------------------------------------------------------------- 

版本 v9.2  

問題類別 OrCAD Capture  

標題 orcad 轉 autocad  

詳細說明 sch 轉為 dxf 檔時,零件無法喊和線段對 ?  

 

RE  

您所敘述的問題我已幫您測試過了 並無您所說明的線段與零件分開的狀況 生  

如果您是使用試用版的軟體則可能會有相同的狀況 生 如果您是正式版的軟體可能是 境 

檔有問題所造成的 您可以將原始程式中的 Capture.ini 覆蓋回去或重新安裝即可  

------------------------------------------------------------------------------- 

版本 9.10  

問題類別 OrCAD Layout  

標題 layout 可以在雙層板都放零件嗎?  

詳細說明 在 layout 裡雙層板上下兩層都可以手動佈件嗎? 

請教教我  

 

RE  

只要您的 Layout 層別設定為兩層以上 在選取元件後按 T 鍵即可放置於相對應的層別中(如 TO 

P 對應 BOT) 放置完 後再使用手動佈線即可  

------------------------------------------------------------------------------- 

版本 7.2  

問題類別 OrCAD Capture  

標題 版本轉換  

詳細說明 7.2 版的 schmetic 用 9.1 版 edit 之後無法再存回 7.2 版,(出 訊息 

DSM0006),請問如何可再存成 7.2 版,Thanking!  

 



RE  

您在讀入 Capture 7.2 版本的電路後請先儲存為 9.1 的格式再進行編輯 編輯完 後於儲存時 

選擇 7.2 的格式即可  

------------------------------------------------------------------------------- 

版本 Ver7.0-S  

問題類別 OrCAD Capture  

標題 不能讀檔  

詳細說明 Capture ver 7.0 為何不能讀 ver 7.2 的檔案?或者需透過其他方法? 

謝謝!  

 

RE  

Capture Ver7.2 比 Ver7.0 較新,程式的架構可能會做些許的變動 

,所此舊的版本想要讀新版本的電路時,可能會有一些問題(不能 

讀檔).因此如果您要讀 Ver7.2 版的電路圖,建議您升級成最新的 

版本,因為新的版本一定可以相容舊版本的電路圖. 

 

 
          資料整理 收藏天地 2001 
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